Time Matters:

Practice Management Software

Time Matters® Version 10 Service Pack 3 Release Notes

This document describes new and enhanced features in this release of LexisNexis® Time Matters, and
provides a list of issues that are fixed in this release and a list of known outstanding issues.
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Before You Install

Be sure to do the following before you install Time Matters 10 Service Pack 3:
e Make sure that a complete backup has been performed on your Time Matters database.
e Close all open applications on your computer.

New and Enhanced Features

Service Pack 3
The following features and enhancements are new in Service Pack 3.
e Support for Worldox GX2
e Support for Timeslips 2010
e Support for Microsoft Office 2010
e Support for Paperport 12
e Support for HotDocs Player 2010 for LexisNexis Total Practice Advantage™

Service Pack 2

The following features and enhancements were added in Service Pack 2.
e Support for Tabs3 version 15
e Support for BES 5.0
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Service Pack 1

The following features and enhancements were added in Service Pack 1.
e Support for Internet Explorer 8
e Updated dtSearch module for Windows 7
e Updated Amyuni print driver for Windows 7

Time Matters 10
The following features and enhancements were added in the original release of Time Matters 10.
e Time Matters Desktop Extensions
e SQL database used for all Time Matters installations
e Data backups that can be run from the command line or automated using Windows scheduler
e Comprehensive Power View showing all information about a case in one place
e Enhancement to “batch create” feature of TM Connect
e Enhanced merge feature to simplify organization and add support for sub-folders
e Enhanced data compression, now using Chilkat instead of Dynazip

Fixed Issues

Service Pack 3
The following issues are fixed in Service Pack 3:

Functional Area  Description Issue #

Account After closing the Print Invoice screen for an open Invoice, the Invoice form is grayed 3114473

Register out.

AutoComplete AutoNaming allows you to save a Document with a period “.” in the file name as the 3111593
initial character.

AutoEntry AutoEntry forms for LexisNexis records allow you to create a web page history that

Forms cannot be saved as part of the AutoEntry form.

Backup / Performing a backup on a machine running the data indexer produces an error.

Restore

Basic Billing The Billing Preferences button does not appear on the Contact form when billing by

both Contacts and Matters
Regarding line on Invoice forms should populate the Contact when a related Matter
ref is entered

Bill Layouts When you preview bills for multiple billing items with the same date, the billing items 3067918
are not ordered by the time entered.
Billing If you add a billing item to an Invoice, the client number is not displayed or saved to
Arrangements the billing record.
When you tag multiple matters and add billing records via the Process menu, the 3131334
resulting billing records are missing rate and billing info.
If a Contact has duplicate Matters with different matter numbers, only one of them 3108862

appears on “This Contact’s Matters” list.
Create a billing item for a Matter and then create an invoice for that billing item; then 3179155
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Functional Area

BlackBerry Sync

Calendar/
Scheduling/
Docketing
Classification
Codes
Contact/Matter
Management

Desktop
Extensions
Document
Automation/
Creation/Mgmt

Email

Exchange Sync
External Links

(Other)

File Locations

Form Tabs

Forms

HotDocs
Invoice Form

Lexis

Lists

Description
save and close the Invoice form and open the Billing Item; client number is missing.
The TMDV utility reassigns billing items to voided invoices.

The Set Field Matching keyboard shortcut (ALT+F) on the Record Options screen does
not work.

The Set Time Interval option on the View menu doesn’t toggle between choices, but
holds all the selected choices.

When editing an existing Contact, if you select an inactive Classification Code, you
cannot save and close the Contact.

If you create a Contact using an AutoEntry form that completes a field, and have a
trigger defined to add an Event when that field is added or changed, the program
takes a long time to save the Event created by the trigger.

Desktop Extensions doesn’t open a Contact from the Search list on Windows 7 64-bit.

The DocsOpen lookup field on Area 5 of Contact and Matter forms is not working.

When you open a Document form using TM Save/PA Save and then minimize the
Document form, if the timer is running on the Document form, you cannot restore and
edit the form window.

When creating a new Document record using TM Save, if there is an invalid character
in the file path, an error message is shown.

If you delete a Document record while its associated document file is open, the
Document record list is not refreshed to reflect the record’s deletion.

Some buttons are not visible on the Select a Worldox Client Code screen.

Deadlines on Demand import causes dates to be off by one day.

Set Show HTML on Email Form to “Always”; HTML email signature still doesn’t display.
Hyperlink email rules are not working.

When a message is opened from the Inbox, focus is on the message box, which cause
the TAB key not to work.

A .wav file selected as the sound to play when new mail arrives does not appear in the
field after closing the lookup window, making it appear that the feature doesn’t work.
Using POP3 email occasionally produces an ODBC error.

Some recurring events are not brought over with the synchronization.

Attempting to open a Worldox record from the Documents sublist produces an error:
Non-numeric in NEAR-BY (“//”)

File locations Default button sets Main Files Directory from UNC path to drive letter.
When adding a new User-Defined Record form tab, the Form Tab Type drop-down
shows a truncated entry for UDRs

When you select an AutoEntry form on a Web record, the web browser covers the
lower toolbar.

Zip codes that start with 0 are truncated when sent to HotDocs

The Staff field on an invoice record is not populated after adding billing items, saving,
and reopening the invoice

When creating a chain or merge template from a Lexis record, the web page history
should be grayed out, as it does not become part of the template.

If a Contact has duplicate Matters with different matter numbers but the same Matter
Reference name, only one of the Matters appears in the This Contact’s Matters list.

Issue #

3064189

3162368

3122211

3110920

2604670

2871596

3154334
2977350
3131066
2608437

3067501
3069181
2996941

3062680

2899997
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Functional Area

Lookup Lists

Merge
Other

Outlines

PCLaw Link
Practice
Advantage

Process Menus
Program Level
Settings
Record Count
Relations

Report/Bill/

Check Designer

Reports

Searches/Filters

Security

Standard
Reports (Billing

Description
If a Matter Reference field is set to only allow users to complete the field by selecting
from preset choices, after completing the field you cannot save and close the Matter.
The Relationship lookup button is not working on the Add Related Record feature.
Contact lookup is not working when you filter the Contact lookup list by code and click
the Change button.

When .dat file for a merge is stored in a local directory, the merge generates an error.

Lines missing when printing a Matter List Notes Powerview from a multiple page Note.

Dragging a document to the Time Matters icon in PaperPort doesn’t bring up the Day
File in Time Matters.

Billing-related Memo fields have untruncated space, impacting performance.
Right-click on Outline element does not provide the option to associate the element
with an existing record.

Time Matters sometimes crashes when using Send to Billing with PCLaw sync.

Broken links on Search Cases screen — CA Litigation

Link to Getting Started document points to version 9.0 document and freezes Internet
Explorer

Date field does not work properly when using the Process > Change Records feature.
For User Defined Records of the Name type, the option to Save Timer Start/Stop
Times in Audit Log should not be present in Form settings in PLS.

Incorrect record count displayed for Invoices, Accounts Payable, and Transaction lists.
Related records are not showing up under the correct Matter when Matter names are
the same.

Default date range causes Standard Reports not to filter GL Accounts correctly.

Attempting to save a billing report to XLS does not save the report.

Some report elements are not aligned correctly in the formatting of Conflict of
Interest reports.

Standard reports sometimes does not display the selected report.

When designing a report for the Transaction list, there are no options for Data Fields
and Field Label.

If a billing address does not populate from a pre-existing Contact or Matter, and you
manually enter an address, the address will not appear on the report.

The Advanced Save option to Save as Basic RTF does not remove graphics and lines as
it should for Basic RTF.

If the Send via Email column is displayed on the Matter list, the text search on all
Matter records will fail. The same thing occurs when Billing Preference columns are
displayed on the Matter list.

Tabbing out of empty Search box on record list clears search results previously shown.
On the Advanced screen of Global Search, entering search terms on separate lines
does not return matching Matter References among the search results.

A saved Advanced Search does not save date selections relative to today.

Adding a Note from the Note Powerview of a restricted Contact shows the Contact’s
Regarding information in the Note form.

If you right-click on a restricted Contact and select Open Contact Journal, the Journal
shows the Contact’s name.

If the date is January, selecting a Date Range of Through Last Month on a General
Ledger Report shows an incorrect date range.

Issue #
3096061

3208062

3086287

3153329

3093904

3107267

3017224

3016288

3030070

3066648

3156424

3030741

3050075

3047820

3042555

3075402

3096054
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Matters)
Sublist

Synchronization

Tabs3

Timeline/
TimeChart

Timeslips

TM Connect

TM Save
Trigger

User Defined
Records

User Level
Settings
Vendors

Wizard
Template

Functional Area

Description

When creating a new Document record related to a Contact, the document merge
produces duplicate pages.

HTML emails sent to a remote database do not show the HTML version on the remote
computer.

When synchronizing one Staff’s records with Outlook, records with multiple staff are
not sync’ed unless the first Staff listed is the one whose records are being sync’ed.
Users cannot match custom categories when synchronizing with Outlook 2007.
When repeated connected synchronizations are run, sometimes Time Matters
attempts to sync records on the remote to the host multiple times.

After upgrading from Tabs3 v11 to v12, Time Matters still detects Tabs3 v11.

When adding billing record for a Matter imported from Tabs3, Time Matters
sometimes crashes.

Record Count displays 0 for the Timeline list.

A record added to the Timeline list does not appear until the Timeline list is closed and
reopened.

Need to disable the Record Count option when the Timeline list is filtered.

On the Timeline list, the Add New drop-down list should not include Contacts or
Matters, and should include User-Defined Records.

For Timeslips field matching, only the first three user fields are listed in areas 4 and 5
of the record form.

Staff field on Contact and Matter records is not updated during Timeslips sync.

When a Time Matters Classification Code is selected that is not matched to a Timeslips
Case Type, after synchronization the Timeslips record shows a default Case Type
unmatched to the Time Matters code.

Add option to match Contact and Matter codes for Timeslips and Time Matters.
When synchronizing Contacts and Matters from Timeslips to Time Matters, the
records are not being properly marked as billable.

When a text field in Time Matters is matched to a date field in Timeslips,
synchronization produces a runtime error.

In Outlook 2007, with Attachment Handling option “Document records related to the
email” selected, trying to TM Connect an archived file produces an error message.

In Excel 2003, clicking TM Save causes a Debug window to appear.

In a fresh installation with only one trigger added, double-clicking the trigger does not
open it.

When mapping fields on the custom import form, you cannot type a space in the
Description field because the spacebar causes the Select Field window list to open.
Reminders for UDRs only appear for the primary Staff if multiple Staff are assigned to
the record.

The HotDocs link states support for a version of HotDocs that is no longer supported.

On the Accounts Payable form, when typing the partial name of a Vendor, pressing F2
causes the next Vendor in the list to be highlighted instead of the one you typed.
While the wizard template is set ON for Contact and OFF for Matter, the form
template is loaded while creating Automatic relation of Contact from Matter. And
while the wizard template is set ON for Matters and OFF for Contact, the form
template is loaded while creating Automatic relation of Matters from Contact.

Issue #

3143849

3148418

2496486

2417824
3004484

3140204

3096329

3096329

3096030

3142268

3087992
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Service Pack 2

The following issues were fixed in Service Pack 2:

Functional Area Description Issue #
Account Register  Deleting transaction other than top one from the register causes focus to shift to the
top transaction and delete.

Accounts Payable Vendor selected using the keyboard does not hold selection. 2642550

Form

Alarms Event alarm left open for 5 mins and then canceled causes new alarm to display. 2708968

Archiving When archiving multiple ToDo’s with master record, only master record is archived. 2747248
Clicking “View Matter” on the Archive Related Records wizard displays blank form. 2708558
Archiving repeating Event records produces warning that Events are part of a chain. 2450288

Auditing Audit Options are saved even when you click Cancel.

AutoEntry Forms  AutoEntry Forms open even after record creation is canceled.
Browsing Google search pages in the LexisNexis record form causes crash.

“Existing data will be cleared” message when adding form if tab out of form Area 5. 2977660
Event AutoEntry form populated from a Matter pulls in only the last date entered. 2820988
BillFlow Manager  Highlighted Matter cannot be added to BillFlow Manager; Matter must be tagged 2645369

Opening the BillFlow Manager with an existing collection, deleting it and then
creating/opening a collection causes toolbar buttons to be disabled

Billing Reverse entries for General Ledger items applied to wrong date. 2976210
Arrangements
Error: “Bank Deposit must have at least one payment” when printing. 3012531
Fees and expenses in arrangements tab not showing correct amount. 3013749
Memo field does not retain edits in Transaction forms. 2988485
Billing statements are not focusing within the date range specified. 2704167
When entering deposit, money deposited into incorrect account. 3043600
Billing Item List When adding Billing Item via CTRL+N (Save & New), rate sometimes isn’t filled in 2398120
when you select a Staff.
Billing Matters Allocation changed if you have tax calculating on a bill, have not posted to GL, and 2685007
open the payment, then save; if you save and close twice, tax is added twice.
Write up/Write down Standard Report showing incorrect figures. 2608967

BlackBerry Sync Add support for BES Server versions later than 4.0.

Update BlackBerry Sync applications version number to 10.
Calendar/Sched- Repeating Event forms are blank when clicked in the Calendar. 2655332
uler/ Docketing

Calendar entries not printing completely. 2649657
User can see private Events marked as private on Calendar, except in parallel mode. 2639250
Date Calculator not skipping custom holidays. 2996165
Events disappear after selecting large number of Staff. 2959975
Chain Templates/ ToDo created in chain not completing correct fields. 2837879
Scheduling Chains
Data Indexer Renaming a file in index directory generates error that does not describe problem.
Desktop Need clearer documentation on In From/Out To fields.
Extensions
References to Time Matters in Practice Advantage installation.
DMS Links (TM Excel macro saves as .xIsx when using Excel 2007, even if Excel is set to save as .xls. 2733036
Save/Open/etc)
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Functional Area

Document
Automation/
Creation/Mgmt

Email

Exchange Sync
Forms
GL

Help System

HotDocs
Imports

Inheritance
Installation
Invoice Form
Lists

Lookup Lists

Merge

Message Boxes
Monitor—Contact
[Matter

Notes

Outlines

PCLaw Link

Power Views

Practice
Advantage

Private Driver

Process Menus

Description
TM Connect strips out sender’s address(es).

Cannot use Send to Time Matters on multiple (5+) documents selected in Windows
Explorer (Vista).

Creating a new Document from a Matter record and saving it without a file name
produces “invalid filename” error message.

When adding multiple documents via Send To TM, not all docs are created.
Viewing Document from Matter form gives message that document does not exist.
Staff field on email contains sending Staff instead of replying Staff

When you “Email as Document” or “Email as PDF” a Document on Docs tab of
Contact/Matter form, the email address is not auto-populated.

“File As” field in Outlook is not populating via Exchange Sync.

Contact records and date-based UDR’s can be saved w/o completing required fields.
Invoices & Opening Balances with finance charges always create interest income
even if another account is showing in the GL Account area for finance charges.
When reversing payable, GL accounts are not all credited properly.

Help contains two identical topics on customizing area layout on record forms.
New User Wizard topic: note that Password field is only required if security is on.
Technical Support and Update Information links are outdated.

Tech Support link needs to be changed to new URL.

“Time Matters - Matter answer source cannot be found” error.

No option to leave records tagged when exporting.

prop_legal TPS file doesn’t import correctly from version 9 to 10.

Inheritance incorrect adding record from user-activated Trigger or Power View.
Network update does not function if UAC turned on in Windows Vista

Staff not showing on Invoice form.

After creating and saving a ToDo or Event, focus is random upon return to list.
Pressing F2 with cursor in Matter Regarding or Matter Number field does not display
This Contact’s Matters screen.

TM Word macro not functioning correctly; INI file is not being correctly created.
Messenger opens with focus on previous message viewed.

Monitor message appears opening User Defined Record outside monitor’s scope.

Cannot insert both time and date on the same note body.

When associating an outline element with an existing record, the list of records
cannot be sorted/searched.

Org Contact changed to Person if there is data in Last Name field when Contact is
sent to PCLaw

Documents in the “Doc View” Power View don’t sort in correct (ascending) order.
Filtered Power Views not working correctly.

Advanced filter for Power View setup is missing properties in “Field” drop-down.
CA Litigation forms: BOE-58-AH outdated, GC-320 does not open.

A slash character in the Matter Ref field causes program to freeze when sending to
HotDocs Player.

Document Security Setting error message when doing Advanced Save - Save to PDF;
Amyuni driver encryption function not applying security settings to PDF document.
Broken Cancel button on last screen in Change Records process for user records.

Issue #
2660422
2749224

2663761
2749224
2739956
2644835
2625494

3045329

3054822

3035443
2821679
3079331

2723235
2707332
2627316

2708717

2690353

2571642
2661780

2932938
2995854
2728259
2722260
3009918
2965908

3033558
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Functional Area
Quick Item Entry/
Timesheet

Quick Tabs
Regarding Fields

Relations

Report/Bill/
Check Designer

Reports
Scanning

Searches/Filters

Sort Order - List
Sublist
Synchronization

Tabs3

TM Save
Transactions

User Defined
Records

Vendors

Time Matters:

Practice Management Software

Description
Inconsistent screen behavior using ALT+F5 to open Quick Item with Timesheet open.

Quick Tab that filters Staff on Invoice list does not work.

Updating Contact Number on Regarding line of a Matter form does not auto-update
the client name.

Creating a specific-relation Billing record from Contact/Matter auto-populates
Matter Reference; this should only happen with automatic (not specified) relation.
Font color setting not staying selected in custom reports.

Database reports not sorting correctly.

Filter for Fund Activity Report doesn’t allow you to filter by responsible attorney.
Time Matters scan dpi must be set to same as scanner dpi or image takes up 1/4 of
page.

Sort on Date field blanks out search when “status” is added to the search filter.
Matter lookup - search does not review all fields if no field to search is specified.
Prebills with multiple classification codes not filtering correctly.

Advanced Search won’t delete search filter.

CTRL+F does not function for Date search on Event list.

When you print records resulting from Conflict Search, report is cut off on right side.
Staff security “field based exceptions” do not hold selected fields for Staff.

Sorting on Sent Date column not working correctly.

Document sublist on Matters - crashing caused by large number of records.

Process change MatterRef of Document doesn’t move Doc from old Matter to new.
In Matter form Related tab, SHIFT+T to tag items locks SHIFT key until pressed again.
Outline detail is empty in remote database after synchronization.

Inbox “To” data not synching from host to remote.

Clicking on Tabs3 ID field in Matter/Contact may cause Time Matters to lock up.
When importing classification code from Tabs3, Time Matters suggests incorrect
code.

Cannot link Tabs3 v15 to Time Matters if a previous version has already been linked.
Regarding field not auto-completing when you TM Save a document.

Finance charge from opening balances continuously post if doing partial payments.
After posting master payments you can go back and check/uncheck individual
payments.

Records can be saved without having a valid entry in a validated lookup field.

UDR records missing from Related Records report.
Creating new Vendor record from a Contact causes crash.
Up/down arrows do not work in the Vendor list.

Fields added to default Vendor list do not sort properly.

2761463

3032391

2526874
2518879
3034555

2993092
2976694
2830405
2815089
2641378

2610425
2677077
2724641
2535664
2829563
2979166
2985157

3001485
2756555
2604496
2864278

2699098

2639327
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Service Pack 1
The following issues were fixed in Service Pack 1:

Functional Area Description Issue #
Archiving Batch archive skips chained records. When archived, chained records cannot be

retrieved. Message that some records were not processed due to being in a chain.
Auto Entry Forms  The Gross column in the Billing Form adds extra zeros to the gross amount if an Auto 2698173
Entry form is created.

Contact and matter Auto Entry forms populating extraneous data in secondary and 2986520
additional tabs when code is part of the Auto Entry form.
Backup/Restore Backup during import: Even if no filename is specified during the folder creation,
you always get a prompt that a file exists, even though it does not.
Basic Billing The wrong billing items could be imported into an invoice when users use the "Add
Billing Items" button.
Billing Basic Billing: Missing billing items in the invoice. 2777190
Arrangements
BlackBerry The Help button associated with BlackBerry Synchronization Setup does not launch

Synchronization the help program—Nothing happens when you click the Help button.
BlackBerry Setup: Accelerator Key “ALT + 0” is linked to multiple functions, and in
some instances, shortcuts are missing.
BlackBerry OTA: The tmbbcfg.exe configuration app does not contain Help button.
BlackBerry OTA: The tmbbcfg.exe Server Information Accelerator shortcut “ALT + B”
is tied to multiple functions and should be changed throughout this wizard.
BlackBerry OTA: Security Profiles and User Groups are displayed as Users in the
tmbbcfg.exe on the List of Users screen--this list should only display Users.
BlackBerry User Configuration: The Accelerator shortcuts for Staff, Date, and Filter
sub-tabs are not working.
BlackBerry Setup: the option “Expand Groups to Show Individual Members Records”
never becomes available.
BlackBerry OTA Setup: Server Information - "Time Matters Server" should be
updated with more explanatory text to minimize incorrect setup and support calls.
BlackBerry OTA Configuration: Configure Time Matters User--the Column Header
text for "User Initials" is cut off.
BlackBerry OTA Configuration: The Next button has graphical display issues.
BlackBerry Sync Setup: Options - Help button links to the wrong topic(s).

Calendar/Sched- Calendar: CTRL +T on the Staff selector pane has a limitation of less than 100. 2959975
uling/Docketing
Database At end of Initial Configuration Wizard, the Finish button does nothing but cause the
Creation text to flash; should have more focus to provide users with additional direction.
Add more detail to screen that shows SQL Servers found during database creation.
Data Indexer Index flag is cleared when Time Matters v10 is opened. 2969068
The Data Indexer starts up and then shuts down. 2972183
Desktop Add a message stating that you can only email one document per email. The
Extensions Document Viewer has a right-click option to email and a button on the fly-out for

emailing. If clicked while multiple documents are tagged, only one will be attached.
Re-design the arrow buttons on the agenda viewer.

Contact Viewer: Add Cell Phone Number to contact viewer fly-out.

Desktop Extensions crash when converting phone pad records.

Search results in Time Matters are not consistent.
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Functional Area Description Issue #
Security issue: “Favorites” does not change when users changes.
Add error reporting capabilities.
Total Practice Advantage DB's get activation error and can’t use Desktop Extensions.
DMS Links (TM With the cursor in the “To” field of a new email message, using the Insider to paste
Save/Open/etc.) in an email address, it pastes into the body of the email instead of the “To” field.
The “PA Save” function for PowerPoint is using the TM Save icons instead of the

ones needed for Total Practice Advantage.

Email Email Attachments are not being restored when email is restored from recycle bin.
The email signature does not show with HTML turned on. 2977350
Exchange Sync Information in the “File-As” field is not being updated as expected--Org with no

first/last are being filed as O. Last name only, no Org, is being filed as N.

Import 9.0 Exchange Information Option Display issue: if you open the ExConfig

application, imported changes won’t display until you close and reopen ExConfig.

Events created in Outlook 2003 with # signs will not sync. 2883275
Feature Packages Feature Packages import issue with Auto Entry Forms.

The Feature Package Import process has several screens with formatting issues.

The Package Unlock Code Screen has several formatting issues.

Form Tabs Form Tabs that are set to create sublist tabs by Quick Tabs displays incorrectly.
Help System Help Menu: The Technical Support and Update Information links are incorrect.
Imports Importing a Time Matters 8 document Index into v10 displays as "Not a valid index".

The Product name is displayed incorrectly in initial import wizard.
Merge Templates that displayed in Time Matters 9.0 will not display in version 10.0. 2967553
Installation Program files are not uninstalled completely with the uninstall routine.
A new EUSA for Time Matters to allow for error reporting.
Lists Make the Quick_Tabs on the sublist work the same as the Main Lists and not allow
other Quick_Tabs to be listed before the All Tab.
Added options to the Matter list not sorting correctly. 2752893
When a ToDo/Event is created and then Saved and Closed, focus will return to a 2707332
random entry on the list.
Matters inside the Matter list losing focus to another matter when opening Billing
preferences using CTRL+B.

Matter Form Newly created Matter forms are not reflected in the list when created through File >
New Record > Matter.

Merge Date formats are not coming through in the merge. 2744570
Merge Templates are not recognizing the Date display format selected. 2785104
Merge Template not displaying manually entered and save location for .dat file. 2971256

Other The Up and Down arrows pointing to Next/Previous records within different forms

works inconsistently.

The “Default” background is not showing for the Workstation Level Setup mode.

The Tech Support number has changed and must be updated in all applicable

locations accordingly.

Updated links under Help Menu and Training and Support Navigators in Time

Matters and LexisNexis Total Practice Advantage to point to accurate web links.
Outlook Accepting a meeting notice in Outlook with a response causes an ADX error.
Integration

Field mismatching in Time Matters - Outlook Synchronization. 2785489
PayFlow Manager Vendor Payable and Credit Memos are added together in the PayFlow Manager, and

paying them thru the PayFlow Manager doesn't always work.
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Functional Area
Payables
PCLaw Link

Power Views
Relations

Re-Login
Reverse

Payments
Searches/Filters

Security

Send To

Staff and Users

Sublist
Synchronization

TM Save
Transactions

Trigger
User Defined
Records

User Wizard
Utilities

Description
The Payable List does not show “Departments” in the Dept. Column.

Time Matters notifications in PCLaw send the wrong client-introducing attorney to
the Time Matters Contact.

The Power View Name/Text search functionality is not working.

Document records created via inheritance are created as both Automatic and
Specified relations.

Updating Client & Client No. results in only Client Name updating on related records.
The Matter No. field does not validate if it is not performed first.

Custom Export breaks the Re-login process stating that the SQL server is unavailable
or has been taken offline.

Reverse Payment doesn’t always recognize that a payment has been deposited. If a
payment has been deposited, you can’t delete the entry, but you can still reverse it.
Document Search: Hits that occur based on the file path and not in the doc/file
cause a Runtime Error.

Global Search does not return all expected results.

Global Search doesn’t find Contact w/ middle initials if wildcard is used in first name.
Non-administrative users can still log in when Maintenance lockout for non-
administrative users is enabled.

Related billing sublist records are visible to users even though security settings are
set not to allow them to View, Add, Chg, or Delete Normal and/or Private records.
Special Exceptions are not filtering out overall Security Settings on billing codes.
Even with access to Utilities blocked, users can still access the Duplicate Contact
Checker under the Utilities Menu (File > Utilities > Duplicate Contact Checker)

The Vendor list can be accessed even when access has been restricted or blocked.
Users can view restricted Contact info using the "email as vcard" functionality.
Users can view restricted Event information using the "email as ical" functionality.
A user with restricted Contact access can get access through the Duplicate Checker.
“Send to Time Matters” in Windows Explorer contextual menu for Version 10 shows
old, not current Time Matters Icon.

New User form should indicate that the User ID is a required field.

Long staff names push “Inactive” off the viewable area.

Inactive Staff members are displayed in Event records as Active.

Right-click on document sublist to view an invoice from a Matter form results in an
error message due to an incorrect path.

Remote Sync: Opening a newly created Remote database for the first time prompts
an import.

Using a dot “.” in the Description field truncates the Filename field.

Bill Express: After adding a Bill Express payment and clicking “Save and New” does
not allocate the payment.

Triggers based on Archiving do not fire if Archiving is done from the Process menu.
When using the “Save and Copy” or “Copy Record” button, audit entries are not
created.

If the “Auto Archive When Done” is checked, then “Save Start and Stop Times”
options do not work.

The Initial 'New User' wizard does not prevent users from creating '"ADMIN' user ids.
Batch Archive: Does not support UDR records but says "All Dated" in Help.

Doc Index Mgr: Deleting an index does not remove the index listing.

Issue #

2924719

2640730

2708663

2774069

2970663

2955363

11 @ LexisNexis-



Time Matters:

Practice Management Software

Time Matters 10
The following issues were fixed in the original release of Time Matters 10:

Functional Area Description Issue #
Account Account Register does not show updated balance that includes Finance Charge from 2621084
Reconciliation Account Reconciliation.
Account Register  Deleting or voiding a Check with a Department selected does not reverse out of the
Dept properly
Alerts, Reminders User Defined Record fields cannot be viewed on Alerts, Reminders, and Watches.
and Watches
AutoEntry Forms  Cannot creating an auto entry form with required fields unless values are provided. 2541318
Backup/Restore Status window does not display.
Check box option to “remember this destination” on Backup screen does not work.
Bill Codes Department codes are not saved in Billing Preferences or in the Staff options form. 2668465
Billing Departments not sorting or subtotaling correctly in custom billing reports.
Arrangements
Billing Item Opening billing item from timeline tab opens a Time Matters/Juris Matching Billing 2716316
Records Form.
Billing Matters A Matter list customized to show Fund 1 Balance errors when sorted. 2504574
Save and copy of Billing records does not clear the transaction ID field.
Enter opening balances does not clear the transaction ID from the billing record.
Using Receipt Allocation Methods Markup and Discount % amounts are being 2771622
allocated incorrectly to GL.
Calendar/Sched- Regional time format (hhmm) gets cut off in 5 day calendar printout.
uler/Docketing
Unable to delete Time Matters Multi-Day Events from within the Calendar. 2694169
Data The default list layout of the Document Form Tab does not include checkout status.
More accurate error message needed when Time Matters loses network connection
to the database.
Data Link Datalink not able to make relationships from billing items to matters.
DMS Links (TM TM Save is not functioning in Excel 2003.
Save/Open/etc.)
Document Interwoven matters are not displayed or searchable from "Go to the Matter". 2731388
Automation/
Creation/Mgmt
Advanced Save from Report preview with “Create Time Matters Document Record”
option selected crashes Time Matters.
Email Deleted attachments are not removed when using the option to store attachments
outside the database.
Inbox populated with blank emails.
Attachment toolbar intermittently does not show up on HTML emails.
Attachments deleted from an email individually are not deleted from Windows.
Staff field on email containing sending staff rather than replying staff. 2644835
Emails in the Sent Items folder in the Inbox that both Show on List and Show on 2676305

Inbox are both checked even when an email is successfully sent.

Deleting an Email from inside the Email puts a copy of the Email in the Deleted Items
folder when setting is OFF.

Cannot send external email messages from a Time Matters user with a username of
maximum length characters (10).
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Functional Area
Exchange Sync

Field/Area
Customization /
Form Styles
Forms

Help System
Inbox and Email

Installation

Lists

Lookup Lists

Merge

Navigators
Other
Payables

PCLaw Link

Power Views
Practice
Advantage

Process Menus
QuickBooks

Description
Time Matters login required for Exchange configuration doesn’t release user license
on logout.

Turning off option for "allow TM to add contacts in Exch" causes updates to fail.
When an admin changed a user’s expired password for Exchange, the sync with
Time Matters did not resume and the user still received password change
notifications.

Changes on a custom form not saved unless user tabs or clicks out of the field.

Automatic Case/Matter file numbers reset to 0 on import.

The "Troubleshooting" topic in the help files points to the Time Matters home page
instead of the knowledge base.

Set regarding from the inbox on email with attachment causes error when
attachments are stored within the database.

Windows explorer will launch the Time Matters installation when laptops are
removed from network.

Adobe Acrobat program features not installed by default when using Adobe 9 Pro.
Cannot sort by billing preferences columns on Matter list.

ALT+F12' hotkey does not open Invoice list.

The setting to "show which relations..." does not work on List Data Area.

When two contacts have the same last name the contact lookup or using F2 goes to
wrong contact.

After performing a merge to Word, Time Matters takes focus from Word.

Data source not found when using default settings.

Merge template setup crashing when clicking back and forth between the Fields,
Settings and Files tabs repeatedly.

Merge creates File Name with WPD extension when using old templates.

Merge allows user to create WordPerfect documents with no name.

Knowledge base button on training and support navigator points to wrong site.
Lexis and Martindale Links open improperly.

Arrange icons doesn't have any function. (Removed in v10).

While in Notes striking the return key may cause behavior as if the CTRL key is stuck.

Recurring payables skip January 1, 2009.

Recurring Payables set for the last Friday of every month are skipping August.
Timesheet fields truncated on a billing item.

Cannot use Task Code rates in PCLaw. Time Matters only uses rates matter rates.
The Sent Date on the Billing List does not sort.

The Amount column is not sorting correctly in PCLaw Worksheet.

PCLaw creating duplicate matters in Time Matters.

Save and close of billing item after bill create not working.

Filter does not stick in Power View showing related UDR records

Bankruptcy Navigator's Client Short Intake Form page is missing.

The Bankruptcy Initial Filing links generate errors.
LexisNexis Total Practice Advantage Estate Practice: Bad Links in new forms.

On the Notes List several Process menus in the list toolbar are not working properly.

QB Server does not configure for LexisNexis Total Practice Advantage without a
Billing Matters license.

Issue #

2741133

2419395

2686827

2693331

2633634
2634699

2689460

2668152

2664833
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Functional Area
Recycle Bin

Report/Bill/
Check Designer
Reverse Payment
Searches/Filters

Security

Staff and Users
Standard Reports

Sublist
Synchronization

Timeslips
Tooltip
Transactions

Trigger
User Defined
Record

Description

Delete of a tagged item lists a duplicated of the next item on the bottom of list.

Recycle Bin performance is slow.

Print of Autotxt codes longer than three characters is truncated. 2531164

Reverse Payments made on Prepaid Payments result in a 1-sided entry to the GL.

Searching on the referred by field not working correctly.

Global search does not complete when searching Outlook. 2572071
Matter custom search has a staff search field that is mislabeled as "code".

Web Search of LexisNexis Research passes incorrect URL to Firefox.

Data Indexer first execution in Time Matters 9 did not index archived records.

Document Search > Create Document Profile Records unresponsive.

Sizable security windows.

Private contact and matter names are seen by users w/o permission on TM Save. 2379362
Inactive staff showing when adding records. 2481607
If customer closes books at the end of the year, then filters that use a “fictitious”

journal entry for year end closing will reverse their manual closing entry.

Related record not displayed when the sublist is loaded with more than 100 records.

Remote synchronization changing multiple record types when no changes are made. 2506545

Document records do not synchronize. 2538887
Repeated synchronizations fail for items created on remote database. 2697638
Incorrect remote database synchronization with follow tagged. 2646574
Remote sync entry fields — remove 80 character limit and increase to windows

standards.

tmtslip.dll is no longer needed and should be removed from the application.
Associate Outline Element button and the dropdown do not work.

Adding trust accounts in the billing preference funds tab causes checks not to be
printed for AR Fund.

Email trigger set to create a chain on delete does not work.

Memo field does not fully maximize.

UDR Description Field does not show lookup button after setting record to lookup

from Record.

Quick_Tabs that use advanced searches as filters do not function properly.

Create names are not shown on Add Record.

Adding through process menu can cause inaccurate dates in custom date field.

Calculated fields do not function on reports. 2663476
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Known Issues

Fixes for the following issues are planned for a future release:

Functional Area Description Issue #
Billing Reverse payments have to marked reconciled and unreconciled on the 3104654
Arrangements register for them to showup in the Rec account to be reconciled.
The Accounts Receivable report does not balance with the GL report. 3194958
Powerviews Related Contacts do not display correctly in a Powerview on the UDR3 list 3157825
(User Defined Records).
QuickBooks Saving a Contact or Matter with more than 50 characters in area 5 producesa 3167149
QuickBooks link error.
Quick Tabs After defining a Quick Tab that filters based on the Status field and then 3051176
displaying the Next Invoice field on the record list, the list goes blank.
Report/Bill/ Report specifications: problem filtering Contacts with Org name only. 3119051
Invoice/Check
Designer
The Receipt Allocation report does not match the billed total for a Matter. 3051875
The Fee Allocation report shows information even when not selected. 3068003
Searches/Filters Global Search not picking up linked Interwoven document profiles or records. 2625761
TM Connect TM Connect grays out when read receipts or delivery receipts are selected in 3052510
Outlook.
User Defined List data area on a record form will not show relations by Matter for User 2920983
Records Defined Records.
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